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Introduction 

This eBook contains the tutorials for the Ryerson University Graphic 
Communications Management course, GCM 738 “Photoshopped! 
The Art of Image Retouching.” 

GCM 738 was proposed as part of the new curriculum that was 
developed in 2012–13 and was first offered in 2017. Since then the 
course has been taught by authors Richard Adams and Jason Lisi, 
with help from numerous part-time contract lecturers. 
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Tutorial 1 • Overview of 
Photoshop 

The Photoshop Workspace 

Before we get into the specific tools found in Photoshop, let’s look 
at the Photoshop Workspace. 

Photoshop interface 

1. Launch Photoshop. 
2. Create a new file that is 8×10″ and 300 ppi in the RGB colour 

mode. 
3. Let’s look at the following: 

Tutorial 1 • Overview of
Photoshop  |  3



◦ Menu bar – This shows File, Edit, Image, and other menus 
that will allow you to execute various commands, 
adjustments, and the enabling of panels. 

◦ Options bar – Displays options for the specific tool that 
you are currently using. 

◦ Tools panel – These are the tools that you can use for 
editing images. Similar tools are grouped together and can 
be found by clicking and holding a tool in the panel. 

◦ Panels – These are other panels that contain various 
controls when working in Photoshop. 

◦ Document Window – This is the space where you are 
currently working in. 

There are three main features that Photoshop is known for: 

1. Selection – The ability to select certain pixels in an image. 
2. Layers – These are similar to transparent sheets stacked on 

top of each other. Through the transparent areas, you can see 
the layers below. If you’d like to adjust which layers appear 
before the others, you can change the order of the layers. 

3. Masking – This allows you to hide or reveal parts of an image 
without destructing or erasing the image. Masking is an 
important part of non-destructive editing which will be used 
throughout the course. 

Editing Non-Destructively 

Non-destructive editing is a valuable tool in Photoshop, enabling 
you to edit images without changing the original. You can then go 
back to a previous state, make changes easily, and show what you 
have done. 

Tools of non-destructive editing include the following: 
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• Layers 
• Layer Masks – When attached to Layers, selectively hide or 

show the Layer 
• Layer Effects – Applies special effects to Layers 
• Duplication of Layers – Editing the duplicate, and leaving the 

original untouched. 
• Applying tools to a Layer with “Sample All Layers” checked; 

applies the edit to the Layer on top, not to the original 

The figure below shows how Layers and Layer Masks work. 

Layers and Layer Masks are important tools in non-destructive image 
editing. In this example, an opaque white layer sits on top of a red layer. The 
mask attached to the white layer selectively hides (black triangle) and shows 
(white triangle) the white layer. 

File Organization 

File organization is very important, especially for image editing 
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where there can be several renditions – or versions – of the same 
image at varying stages of editing. 

Naming conventions. When working with images that will be 
edited in Photoshop, use names that are short and descriptive. In 
all cases, it’s best to avoid spaces and special characters in file 
names. For example, spaces should be avoided because, on the web, 
spaces confuse the server and have to be replaced by “%20” as filler 
characters. In place of spaces, use hyphen or underscore. Other 
illegal characters include most symbols (e.g. #$@) and slashes. 

It is highly recommended that images that have more than one 
version are given version numbers that ascend numerically to 
indicate which photo is the most current. In addition, the final 
image should be tagged with the word “final” in the name. 

 

Suggested file organization for print and web pages. 

6  |  Photoshopped!

http://pressbooks.library.ryerson.ca/photoshopped/wp-content/uploads/sites/128/2020/07/image3.png
http://pressbooks.library.ryerson.ca/photoshopped/wp-content/uploads/sites/128/2020/07/image3.png


Folder Structure. In addition to diligent naming conventions, a good 
folder structure is also very important to help keep things 
organized. It is recommended that you come up with a master folder 
structure, and use that master folder structure on all your jobs to 
ensure consistency. 

Create a “Master File Structure” Folder 

1. On the Mac, navigate to your USB drive. 
2. Inside your USB drive, create a folder named 

“GCM_738_Fall_2020” 
3. Inside the “GCM_738_Fall_2020” folder, create a folder 

named “GCM_738_Master_Folder_Structure” 
4. Within the “GCM_738_Master_Folder_Structure” folder, 

create the following folders: 

◦ 01_Original_Images 
◦ 02_Altered_Images 
◦ 03_Working_Photoshop_Files 
◦ 04_Final_Images 

Selection, Masking, and Layers in Action! 

In this short exercise, we will replace the sky of an image using 
Photoshop’s key features of selection, masking and layers. 

1. Open the tutorial file named 
GCM738_Tutorial_01_Building.tif. 

2. Select the Rectangular Marquee Tool and create a rectangular 
selection anywhere on the image. 

3. Select the Move Tool to move the selection.  This is how you 
can select and move pixels in your image. 

4. Undo this move by pressing Cmd + Z or Ctrl + Z 
5. To deselect the section, press Cmd + D or Ctrl + D 

Tutorial 1 • Overview of Photoshop  |  7



6. Now let’s try to select the sky using different selection tools. 

◦ Lasso Tool –  allows you to make freehand selections. 
◦ Polygonal Lasso Tool – allows you to make a selection by 

connecting straight lines. 
◦ Magnetic Lasso Tool – allows you to make a selection by 

snapping to edges in an image as you drag. 
◦ Object Selection Tool – allows you to select an object 

within a defined region. 
◦ Magic Wand Tool – selects an area based on its colour. 

This works well for solid colours. 
◦ Quick Selection Tool – allows you to make a selection by 

finding and following the edges of an image. 

7. You can also select using the Menu Bar 

◦ Click on Select in the Menu Bar 
◦ You have the ability to select a Focus Area, Subject, or Sky 
◦ Photoshop will then select those areas for you using 

artificial intelligence 
◦ Notice that when we select Sky, some of the sky is also 

selected in the window. The artificial intelligence is good 
but not always perfect. 

◦ For this exercise, we will select the sky using the quick 
selection tool or the object selection tool. 

8. With the quick selection tool selected, change the brush size 
in the Options Bar to about 150 px and select the sky area. 

9. Once the selection is made, in the Menu Bar, go to Layer → 
Layer Mask → Hide Selection 

◦ Notice that the sky is now gone because a layer mask has 
been created. The pixels are hidden but not erased or 
deleted. If we wanted to bring back the sky, we could easily 
do so. This is non-destructive editing. 
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10. Drag and drop the image of the new sky into the Photoshop 
file. 

11. In the Layers Panel, drag the new sky below the original image. 
12. Using the Move Tool, resize the sky to fit appropriately in the 

background. 

This is a very simple way that demonstrates how you can use Photoshop’s key 
features to edit an image and replace a sky 

Photo by Harry Shelton on Unsplash [New Window] 
Photo by Andre Iv on Unsplash [New Window] 

Publishing Your Images 

File Formats 

After retouching your images in Photoshop, you may wish to publish 
them in a variety of media—magazines, posters, books, eBooks and 
their covers, and web pages. Each type of media requires a different 
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file format and resolution. Printed images should be in Photoshop 
(.psd), TIFF (.tif), or JPEG (.jpg) format, while images for eBooks, web 
pages, and social media should be in JPEG, PNG (.png), or GIF (.gif) 
format. 

 

Image File Formats 

Format Description Compressed Transparency

PSD Photoshop No not needed 

TIFF Tagged Image File Format Optional not needed 

JPEG Joint Photographic Experts Group Yes No 

PNG Portable Network Graphic Yes Yes 

GIF Graphic Interchange Format Yes Yes 

Notes 
1  Transparency refers to making the background clear for use in web and eBooks. 
2  Web formats also apply to eBooks. 

Use File → Save As to save PSD and TIFF files for print. 
Use File → Export → Export As… for saving JPEG, PNG, and GIF 

images for web. 
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Making a Printed Magazine Cover, Book Cover, 
or Poster 

Covers of print books, along with posters, are best made in Adobe 
Illustrator (for single pages) or Adobe InDesign (single- and multi-
page documents). The New Document dialog box in InDesign offers 
options for page size, automatic text frame, facing pages, and bleed: 

• The automatic text frame, which is useful if your book includes 
a lot of type, will create new pages to accommodate the type; 
not necessary for single-page documents. 

• Facing pages is useful for print books where you want different 
layouts for left- and right-hand pages; usually not necessary 
for single-page documents. 

• Bleed (usually 1/8″ or 0.3175cm) is necessary if your page has 
color printing up to the edge; the page will be printed on larger 
paper and trimmed to final size. 
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Image Requirements for Publications 

Publication Type Image 
Resolution Document 

Magazine Cover/
Full Page 300ppi 

InDesign or Illustrator 
U.S. Letter or A4 (8½×11″ or 
210×297cm) 
Automatic Text Frame: No 
Facing Pages: No 
Bleed ⅛” (0.125″) or 0.3175cm if 
color to edge 

Book Cover/Full 
Page 300ppi 

InDesign or Illustrator 
U.S. Letter or A4 (81/2×11″ or 
210×297cm) 
Automatic Text Frame: No 
Facing Pages: No 
Bleed: ⅛” (0.125″) or 0.3175cm if 
color to edge 

Poster 300ppi 

InDesign or Illustrator 
U.S. Tabloid or A3 (11×17″ or 
297×420cm) 
Automatic Text Frame: No 
Facing Pages: No 
Bleed: ⅛” (0.125″) or 0.3175cm if 
color to edge 

eBook 144ppi 

InDesign 
384×512px 
Automatic Text Frame: Yes 
Facing Pages: No 
Bleed: none 
Save cover separately in JPEG 
format 

Web Page 72ppi 

Dreamweaver or HTML editor 
HTML page 
<img> tag for image 
CSS specification for width and 
height 
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Tutorial 2 • Paradise Found: 
Retouching Landscapes and 
Other Places 

Overview 

This lab will explore some of the tools and techniques we can use 
to make images of landscapes and buildings look better through 
retouching and colour correction. 

Objectives 

• To demonstrate how to effectively correct lens distortions 
• To introduce the content-aware features of Photoshop 
• To use the Vanishing Point Filter to work with perspective 
• To demonstrate how to use channels as intricate masks 
• To apply colour corrections for enhanced detail and appeal 
• Using brushes to create details in a photo 

Tutorial 2 • Paradise Found:
Retouching Landscapes and Other



Adjusting for Lens Distortion 

One unfortunate reality of photography is that lenses on cameras 
can sometimes distort the images. Luckily Photoshop has some 
great tools to help us correct this. In this part of a tutorial we will fix 
some vertical distortion that was caused by the lens and the angle 
that the image was shot. 

Let’s begin: 

1. Open the tutorial file named 
GCM738_Tutorial_02_Cathedral.tif. 

2. Save the Image as to the 03 Working Photoshop Files folder 
with the name 
GCM738_Tutorial_02_Cathedral_Intitials_v1.psd, where 
“initials” are your initials (e.g. 
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GCM738_Tutorial_02_Cathedral_JL_v1.psd). 
3. Double click on the Background Layer and rename it to 

Original Image. 
4. Duplicate the Original Image Layer, and rename this layer to 

Lens Correction. 
5. With the Lens Correction Layer selected, choose Filter Covert 

for Smart Filters. 
6. Choose Filter Lens Correction. Choose the Custom Tab. 
7. Under Transform, change the Vertical Perspective to -35 and 

the Angle 0.50. Click OK. 
8. Toggle the Lens Correction Layer visibility off and on to see 

the change. 
9. Save the file. 

A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=28 

This 01:32-min. video shows how to use the Lens Correction 
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features of Photoshop. (Video by Nanor Keshishian) 

Photoshop’s Content Aware Features 

This part of the tutorial will look at the Content Aware features in 
Photoshop, and explore ways they can be used to effectively retouch 
landscape photographs. 

 

A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=28 

This 03:38-min. video shows how to use the content-aware fill, 
scale, and move features of Photoshop. (Video by Nanor Keshishian) 
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Content Aware Fill 

1. Open the tutorial file named 
GCM738_Tutorial_02_Beach_01.tif. 

2. Save the Image as a.psd file to the 03 Working Photoshop Files 
folder with the name 
GCM738_Tutorial_02_Beach_01_Intitials_v1.psd, where 
“initials are your initials (e.g. 
GCM738_Tutorial_02_Beach_01_JL_v1.psd). 

3. Double click on the Background Layer and rename it to 
Original Image. 

4. Duplicate the Original Image Layer, and rename this layer to 
Content Aware Fill. 

5. Use the Lasso Tool to draw a rough outline around the man 
and the reflection of his legs in the water. 
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6. Choose Edit Fill, and change the Contents to Content-Aware. 
Make sure Color Adaptation is selected, Blending Mode is set 
to Normal, and Opacity is 100%. Preserve Transparency should 
not be checked. Click OK. 

7. Repeat this process for the two children and the coloured 
floats in the water. Tip: You can use the Shift Key to select all 
the coloured floats at once. 

8. If there is any clean-up to do, create a new layer, and call it 
Cloning. Use the Cloning tools taught in Tutorial 2 to fix up any 
rough spots, such as the two water spots in the sky and any 
“blips” caused by the Content Aware Fill. 

9. Save the file. 
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Content Aware Scale and Move 

1. Open the tutorial file named 
GCM738_Tutorial_02_Beach_02.tif. 

2. Save the Image as a .psd file to the 03 Working Photoshop 
Files folder with the name 
GCM738_Tutorial_02_Beach_02_Intitials_v1.psd, where 
“initials are your initials (e.g. 
GCM738_Tutorial_02_Beach_02_JL_v1.psd). 

3. The client wants this image to fill the whole canvas, without 
increasing the size of the lady sitting on the beach. How can 
we do this? An ordinary scale won’t work, so let’s try a 
Content-Aware scale. 

4. Duplicate the Original Image Layer, and rename this layer to 
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Content Aware Scale. 
5. With the Content Aware Scale layer selected, choose Edit 

Content-Aware Scale. 
6. Start by scaling the image vertically, then horizontally. Notice 

that Photoshop does a pretty good job, but unfortunately the 
lady is still being distorted. 

7. We can solve this issue by “protecting” the lady. To do this, let’s 
use the lasso tool to draw a rough selection around the lady. 

8. Choose Select Save Selection, and name the selection Lady. 
Deselect the selection by pressing Command D. 

9. Choose Edit Content-Aware Scale again, but this time in the 
Options Bar, make sure Protect is set to Lady. Redo the 
Content-Aware Scale and notice how the lady’s shape is 
preserved. 

10. Now the client wants the lady repositioned so that she is 
centered in the image. We can do this quite easily using the 

Content-Aware Move Tool.
11. Duplicate the Content Aware Scale layer and name it Content 

Aware Move. 
12. Using the Content-Aware Move Tool, draw a selection fairly 

tight around the lady and her shadow, and then move her to 
the center of the image. Press enter. Tip: Playing around with 
the Structure and Color settings in the Options Bar will modify 
your results. 

13. Save your file and close it. 
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Working with Perspective 

Perspective can be a bit challenging when manipulating images in 
Photoshop. Sometimes getting things to follow perspective along 
a vanishing point can be tricky. One way to make working with 
perspective easier is to use Photoshop’s Vanishing Point Filter. This 
part of the tutorial introduces us to the Vanishing Point Filter and 
how to use it correctly. 

Let’s begin: 

1. Open the tutorial file named 
GCM738_Tutorial_02_Perspective.tif. 

2. Save the Image as a .psd file to the 03 Working Photoshop 
Files folder with the name 
GCM738_Tutorial_02_Perspective_Intitials_v1.psd, where 
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“initials are your initials (e.g. 
GCM738_Tutorial_02_Perspective_JL_v1.psd). 

3. With the Type Tool, create the text “Perspective” using 
Helvetica Bold at a type size of 72 pts. For the colour of the 
type, click on the colour selector in the Options Bar, and use 
the Eye Dropper to select the off-white area of the sign. 

4. Duplicate the type layer, and then rasterize this duplicated 
layer. We are doing this because the type will have to be 
rasterized to work with the Vanishing Point Filter. Rename this 
layer as Perspective Rasterized. Turn off the original Text 
Layer. 

5. With the Perspective Rasterized Layer selected, choose Select 
All, and then Edit Cut. 

6. Now choose Filter Vanishing Point. 
7. Once in the Vanishing Point Filter, use the Create Plane Tool to 

identify the shape of the sign. Tip: If the outline goes red, the 
shape cannot fit nicely into a plane, so readjust until the 
outline is blue. Now choose Edit Paste. 

8. Move the pasted text into the sign area. Notice how the 
perspective automatically conforms to the plane we created. 

9. Choose Command T for freeform transform, and scale down 
the text slightly to better fit the sign area. Adjust the 
positioning of the text, and then click ok 

10. Save your file and close it. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=28 

 

Using Channels as Intricate Masks 

Masking can be another challenging aspect of retouching in 
Photoshop, especially when the area we are trying to mask has very 
fine, intricate areas. One trick we can use to get around this is to use 
a Photoshop Channel as a mask. This part of the tutorial will look at 
this. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=28 

 
Let’s begin: 

1. Open the tutorial file named 
GCM738_Tutorial_02_Forest_01.tif. 

2. Save the Image as a .psd file to the 03 Working Photoshop 
Files folder with the name 
GCM738_Tutorial_02_Forest_01_Intitials_v1.psd, where 
“initials are your initials (e.g. 
GCM738_Tutorial_02_Forest_01_JL_v1.psd). 

3. The idea here is that we want to remove the existing sky, and 
replace it with the image of the Toronto Skyline named 
GCM738_Tutorial_02_Toronto.tif. The challenge is to 
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quickly and effectively remove the sky without making the 
trees look unnatural. 

4. Double click on the Background Layer, and rename it Original 
Image. Now duplicate the Original Image Layer and name this 
layer Sky Masked. Turn off the visibility of the Original Image 
Layer. 

5. Now go to the Channels Palette. Toggle between the Red, 
Green, and Blue Channels. Notice how the Blue Channels has 
the most contrast difference between the sky and the trees. 
For this reason, we will work with the Blue Channel. 

6. Duplicate the Blue Channel and name it Mask. 
7. With the Mask Channel selected, choose Image Adjustments 

Levels. 
8. Slide the left slider of the Input Levels to about the 150 mark. 

Slide the right slider to about the 160 mark. 
9. Make sure your foreground colour is set to black and your 

background colour is set to white. Use the Paint Brush Tool to 
fill in black spots, and the eraser tool to clean up white areas. 

10. When you are happy with your results, turn the Mask Channel 
into a Selection by clicking the Load Channel as Selection Icon 
on the Channel Palette. 

11. Click on the RGB Channel to show all colours. 
12. Go to your Layers Palette. With the Sky Masked Layer 

selected, choose Layer Layer Mask Hide Selection. The sky 
should now be masked. 

13. Now we need to add the Toronto skyline to the image. Open 
the file GCM738_Tutorial_03_Toronto.tif, then select the 
whole image and copy/paste it into the 
GCM738_Tutorial_02_Forest_01_Intitials_v1.psd file. 
Name the new layer Toronto Skyline, and drag it below the Sky 
Masked Layer. 

14. Scale the Toronto Skyline to fit the area. 
15. Our image looks fake because the foreground is too light. We 

need to fix this. With the Sky Masked Layer selected, choose 
Layer Layer Style Colour Overlay. Make sure the Color is set to 
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black, and set the Blend Mode to Darken. Set the opacity to 
75%. 

16. Now let’s do some final tweaks. Duplicate the Sky Masked 
Layer and name the new layer Trees Darkened. Disable the 
Layer Style on the Sky Masked Layer. 

17. With the Trees Darkened Layer selected, lock the 
transparency on the layer. 

18. Select the Brush Tool and change the Opacity to 40%. Hold 
down the Option Key and sample a dark green area of the 
trees. Now use the Brush Tool to paint over the lighter areas to 
make it look more natural. 

19. Save your file and close it. 
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Colour Corrections for Enhanced Detail and 
Appeal 

Often with landscape images, we want to make the colours look 
better than they were when originally shot. This happens quite 
often in travel brochures, for example. Let’s look at how we can do 
this. 

Let’s begin: 

1. Open the tutorial file named 
GCM738_Tutorial_02_Beach_03.psd. 

2. Save the Image as a .psd file to the 03 Working Photoshop 
Files folder with the name 
GCM738_Tutorial_02_Beach_03_Intitials_v1.psd, where 
“initials are your initials (e.g. 
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GCM738_Tutorial_02_Beach_03_JL_v1.psd). 
3. Duplicate the Original Image Layer and name the new layer 

Colour Corrected. 
4. With the Colour Corrected Layer selected, choose Select Color 

Range. 
5. Make sure Select is set to Sampled Colors, Fuzziness is 

approximately 40, and selection Preview is set to Black Matte. 
Then, using the Eye Dropper select the blue areas. Tip: Hold 
down the Shift Key and keep selecting blue areas until 
everything is selected. Click OK. Do not deselect the selection 
area. 

6. Now go to Layer New Adjustment Layer Brightness/Contrast. 
Name this Adjustment Layer Sky Contrast. Notice how our 
selection automatically converted .into a mask? This will make 
sure we change the colour of the sky without affecting the 
sand. Set the Brightness to -5 and the Contrast to 20. 

7. Now go to Layer New Adjustment Layer Vibrance Name this 
Adjustment Layer Sky Vibrance. Set the Vibrance to 25 and the 
Saturation to 20. Notice that the sand also changed colour. We 
don’t want this, so we will copy the mask from the previous 
adjustment layer to this one by pressing the Option Key and 
dragging the mask to the Vibrance Adjustment Layer. 

8. Select the two Adjustment Layers and make a new group called 
Colour Adjustments. Toggle the layer visibility off and on to 
see the changes. 

9. Save your file and close it. 
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Using Brushes to Add Detail 
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Photoshop Brushes are powerful, yet they are often underutilized, 
especially when it comes to adding objects to images that are in the 
distance, and don’t have a lot of detail. This final part of the tutorial 
will look at how we can use a brush to add birds to an empty sky. 

Let’s begin: 

1. Open the tutorial file named 
GCM738_Tutorial_02_Flying_Birds.tif. 

2. Save the Image as a .psd file to the 03 Working Photoshop 
Files folder with the name 
GCM738_Tutorial_02_Flying_Birds_Intitials_v1.psd,
where “initials are your initials (e.g. 
GCM738_Tutorial_02_Flying_Birds_JL_v1.psd). 

3. Double click on the Background Layer and name it Original 
Image. 

4. Create a new layer and call it Birds. 
5. Now open the file named 

GCM738_Tutorial_02_Bird_Outlines.tif. 
6. Using the Rectangle Marquee Tool, draw a selection around 

the first bird. Choose Edit Define Brush Preset. Name this 
brush Bird 1. Do the same thing for the second bird, and name 
this brush Bird 2. Now return to the 
GCM738_Tutorial_02_Flying_Birds_Intitials_v1.psd file. 

7. Make sure your Foreground Color is set to R 0 G 0 B 0, and 
your Background Color is set to R 110 G 110 B 110. 

8. To make these birds look natural, we have to change some 
settings in the Brush Engine. 

9. Select the Bird 1 Brush. Note that if you try to draw with it, it 
will just make a big streak. This is not what we want. 

10. Open the Brush Engine. Make the spacing 500% and the Size 
50px. 

11. Check on Shape Dynamics. Make the Size Jitter 60%, the 
Minimum Diameter 10%, and the Angle Jitter 15%. 

12. Check on Scattering. Make sure Both Axes is checked, and 
then change the scatter amount to 400%. 
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13. Check on Color Dynamics. Set Foreground/Background Jitter 
to 100%. Set both the Saturation Jitter and the Brightness jitter 
to 40%. 

14. Save this as a new Brush Preset. 
15. Repeat this process with the Bird 2 Brush, only vary the 

settings for each slightly. 
16. Once both Presets are saved, use them to draw some birds. 
17. Toggle the visibility of the Birds Layer off and on to see the 

changes. 
18. Save your file and close it. 

Conclusion 

This lab tutorial demonstrated several key tools and techniques we 
can use to retouch landscapes and places. As with the last tutorial, 
it should be noted that there are many other things we can do, and 
this tutorial is by no means an exhaustive example of everything 
Photoshop can do in this regard. It is also worth mentioning that 
there are several different ways Photoshop can be used to achieve 
the same result. This tutorial only shows some of the many, 
diversified paths that we can take to achieve the same end.Try 
practicing this tutorial on your own, and see if you can complete it. 
Remember, do not hesitate to ask your instructor for guidance along 
the way! 

Tutorial 2 • Paradise Found: Retouching Landscapes and Other Places  |  33



Tutorial 3 • Doohickeys and 
Whatchamacallits: 
Retouching Objects and 
Making Things 

Overview 

This lab will explore some of the tools and techniques we can use to 
make our own backgrounds in Photoshop, as well as retouch objects 
and everyday things. 

Objectives 

• To demonstrate how to effectively use Photoshop to create 
custom backgrounds 

• To learn how to effectively mask and merge transparent 
objects such as glass 

• To explore ways we can enhance the look of product shots 

Creating Custom Backgrounds 

Sometimes we need some cool backgrounds to go with our art. Two 
popular types of backgrounds are metallic and wood grain. While 
it is easy to find many examples of each online, often they are not 
the right size or resolution. Also, when using these backgrounds 
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in projects that will make money, we must be concerned about 
copyright. All of this can be avoided though if we use our Photoshop 
knowhow to make our own! 

Metallic Looking Background 

1. Open Photoshop and create a 
new file that is 11″ wide, 8.5″ 
high, 300 ppi, Color Mode RGB 
and Background. contents set 
to Transparent. Save the file as 
a Photoshop file named 

GCM738_Tutorial_03_Metal_Bkg.psd. Name the layer 
Gradient. 

2. Click on the gradient tool. Create a new custom gradient with 
5 colour points. Use R 164, G 164, and B 164 for the dark colour, 
and R 210, G 210, and B 210 for the light colour. Start with the 
dark colour, and alternate between the dark and light colours. 

3. Hold down the shift key and draw the gradient all the way 
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across the horizontal dimension. 
4. Create a new layer above the Gradient Layer and call it Noise. 
5. Fill the Noise Layer with the colour R 210, G 210, and B 210. 
6. Go to Filter Noise Add Noise. Set Amount to 400%, 

Distribution should be Uniform, and check Monochromatic. 
7. Duplicate the Noise Layer and call it Blur. Turn off the visibility 

of the Noise Layer. 
8. Go to Filter Blur Motion Blur. Set Angle to 0 and distance to 

100 pixels. 
9. Add a Layer Mask (Reveal All) to the Blur Layer. 

10. Change the Foreground color to black (#000000). Pick a large 
soft brush, lower the brush opacity to 65-70% and draw over 
the mask in left and right corners. 

11. Set the Layer Blending Mode to Overlay and Opacity to 60%. 
12. Create a new layer above the Blur Layer and call it Noise 2. Fill 

it with the colour R 210, G 210, and B 210. 
13. Go to Filter Noise Add noise, and set the amount to 10%, 

choose Gaussian Distribution and Monochromatic Effect 
14. Change the layer blending mode to Linear Burn and opacity to 

10%. 
15. Create a new Curves Adjustment Layer and name it Intensity. 

Move the Shadow and Highlight sliders until Input is 
approximately 235 

16. Zoom in to see the file at 100%. 
17. Save the file. 

36  |  Photoshopped!



Wood Looking Background 

1. Open Photoshop and create a new file that is 11″ wide, 8.5″ 
high, 300 ppi, Color Mode RGB and Background contents set 
to Transparent. Save the file as a Photoshop file named 
GCM738_Tutorial_03_Wood_Bkg.psd. Name the layer Render 
Filter. 

2. Set the foreground and background to dark and light wood 
tones respectively. For the foreground you can choose R 125 G 
65 B 0, and the Background can be R 225 G 165 B 90. 

3. Choose Filter Render Fibers. You can play around with the 
settings, but generally a Variance of 20 and a Strength of 8 will 
work well. 

4. Now let’s add some knots for realism. Duplicate the Render 
Filter Layer and call the new layer Knots. Using the oval 
marquee, make two oval selections. Choose Select Modify 
Feather, and set the Feather amount to 60 pixels. 

5. Go to Filter Distort Twirl. Make the angle 950. 
6. Now let’s sharpen the image a little as a finishing touch. 

Duplicate the Knots Layer and call the new layer Sharpening. 
7. Go to Filter Sharpen Unsharp Mask. Set the amount to 95, the 

Radius to 2.5, and Threshold to zero. Click ok. 
8. Save the file. 
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Cloudy Sky Background 

Note: Many people use the Filter Render Clouds feature to create 
clouds, but I find this method limiting and “flat” looking. Instead, we 
are going to create more dynamic clouds using a custom brush. 

1. Open Photoshop and create a new file that is 11″ wide, 8.5″ 
high, 300 ppi, Color Mode RGB and Background contents set 
to Transparent. Save the file as a Photoshop file named 
GCM738_Tutorial_03_Cloud_Bkg.psd. Name the layer Blue 
Sky. 

2. Fill this layer with a nice sky blue colour, such as R 100 G 175 B 
250. 

3. Create a new layer above the Blue Sky layer and call it Clouds. 
4. Now select the Brush Tool, and choose a brush with no 

hardness, and a diameter of approximately 900 pixels. 
5. Now we need to customize our brush by opening the Brush 

Engine. 
6. Under Brush Tip Shape, make sure the diameter is 900 pixels, 

Hardness is 0, and Spacing is 30%. 
7. Under Shape Dynamics, set the Size Jitter to 100%, Control 

should be Fade with a value of 20, and the minimum diameter 
should be set to 20%. 

8. Under Scattering, make sure Both Axes is checked, and set the 
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Scatter amount to 120%. Control should be Off, Count is 10, 
Count Jitter is 100% and Control is Off. 

9. Under Texture, choose the Clouds Texture (Tip: you may have 
to “load” this pattern by clicking on the Settings Sprocket, 
choosing Texture Fill, and Append), Scale 500%, Texture each 
Tip should be checked, Brightness and Contrast should be set 
to 0, Mode is Color Burn, Depth is 100%, Depth Jitter is 0%, 
and Control is Off. 

10. Under Transfer, set Opacity Jitter to 100%, Control to Fade at 
25, Flow Jitter to 0%, and Control to Pen Pressure with 
Minimum set to 0. 

11. Save the Brush with the name Clouds with Capture Brush Size 
in Preset selected. 

12. Select the new brush and draw some clouds on the Cloud 
Layer. Tip: Vary the size of the brush to make unique clouds. 

13. To add some depth to the clouds, add a new Layer Style, and 
give the clouds an Inner Shadow, with Opacity at about 25%, 
Distance set to 0, Choke set to 0, and size set to 5 pixels. 

14. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=69 

Masking Transparent Objects 

Merging transparent objects, like windows or a glass, can be a 
challenge. We want the background to show through, but at the 
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same time we need to retain the detail of the object. What follows is 
just one of many ways we can accomplish this. 

Let’s begin: 

1. Open the file named GCM738_Tutorial_03_Vineyard.tif. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_03_Vineyard_Initials_v1.psd, where 
“initials” are your initials (e.g. 
GCM738_Tutorial_03_Vineyard_JL_v1.psd). 

3. Double-click on the background layer and name it Background 
Image. 

4. Open the file named GCM738_Tutorial_03_WineGlass.psd. 
5. Select all, and copy the image. Paste it into the image of the 

vineyard. Name the new layer Wine Glass Original. Position the 
glass so that it partially covers the grapes on the left. 

6. With the Wine Glass Original layer selected, use the Magic 
Wand Tool to select the background, then choose Select 
Inverse to inverse the selection. Save the Selection as Wine 
Glass. Deselect the selection (Command D). 

7. Duplicate the Wine Glass Original layer, and name it Wine 
Glass Shadows. Hide the Wine Glass Original layer. 

8. Change the blending mode of the Wine Glass Shadows layer to 
Linear Burn, and reduce the layer opacity to 50%. 

9. Duplicate the Wine Glass Shadows layer and name the new 
layer Wine Glass Highlights. Change the Opacity back to 100%, 
and the Blend Mode to Normal. Hide the visibility of all layers 
except for the Wine Glass Highlights layer. 

10. With the Wine Glass Highlights layer selected, go to Select 
Color Range. Make sure Select is set to Sampled Colors, and 
Localized Color Clusters is selected, then use the eye dropper 
to select the lightest part of the glass. Adjust the Fuzziness and 
Range to approximately 30 for each. Click OK. 

11. With the selection still active, click the Add Mask Icon at the 
bottom of the Layers Palette to create a Layer Mask. Turn on 
the visibility for all layers except the Wine Glass Original layer. 

Tutorial 3 • Doohickeys and Whatchamacallits: Retouching Objects and
Making Things  |  41



12. Double-click on the layer mask to bring up the properties. 
Bring the value of Shift Edge down to approximately -30 and 
click OK 

13. Duplicate the Background Image layer and name the new layer 
Background Blur. 

14. With the Background Blur layer selected, load the Wine Glass 
selection, the go to Layer Layer Mask Reveal Selection. 

15. With the image (not the mask) selected, choose Filter Blur 
Gaussian Blur and give the selection a Blur radius of 2 pixels. 

16. Now let’s add some wine to the glass. Make a new layer above 
the Background Blur layer and name it Wine. 

17. With the Wine layer selected, load the Wine Glass selection. 
Using the Lasso Marquee, hold down the Option key and 
deselect the glass stem. Now switch to the Rectangular 
Marquee, hold down the Option key and deselect about two 
thirds of the top of the wine glass. This is creating the shape 
fill for our wine 

18. Fill the selection with the colour R 70 G 0 B110 with Blend 
Mode set to Normal, and Opacity set to 100%. Click OK. 

19. Change the layer Blend Mode to Multiply. 
20. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=69 
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Making Products Look More Appealing 

Figure 5. Making Products More Appealing. 

Companies want their products to look their best so that people will 
want to buy them. There are several tricks and tips we can use to 
improve how a product looks. 

Let’s begin: 

1. Open the file named GCM738_Tutorial_03_Prada_Cup.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_03_Prada_Cup_Initials_v1.psd, 
where “initials” are your initials (e.g. 
GCM738_Tutorial_03_Prada_Cup_JL_v1.psd). 

3. Create a new layer above the Metal Cup layer and name it 
Cloning. 

4. Zoom into 300% and choose the Spot Healing Brush. Make 
sure Mode is set to Normal, Type is set to Content-Aware, and 
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Sample All Layers is checked. Use the Spot Healing Brush to 
clean up any blemishes on cup. 

5. With the Metal Cup layer selected, use the Quick Selection 
Tool to select just the metal part of the cup, then create a new 
layer and call it Cup Gold. Use the selection to create a new 
layer mask by choosing Layer Layer Mask Reveal selection. 
Move the Cup Gold layer to the top of the layer order and fill 
the Cup Gold layer (not the layer mask) with a gold colour that 
is R 214 G 176 B 82. Change the layer blend mode to multiply. 

6. Select the Metal Cup layer, the Cloning layer and the Cup Gold 
layer and make a new group. Name the group Cup. 

7. Add a new Brightness/Contrast Adjustment layer above the 
group Cup and name it Cup Brightness. Adjust the Brightness 
to 35 and the Contrast to -5. 

8. Open the file named GCM738_Tutorial_03_Prada_Logo.psd. 
Select all, copy, and then paste into the 
GCM738_Tutorial_03_Prada_Cup_Initials_v1.psd file. 
Rename the layer Prada Logo Original. Right-click on the layer 
and convert it to a Smart Object. 

9. Duplicate the Prada Logo Original layer and name the new 
layer Prada Logo Altered. Turn off the layer visibility for the 
Prada Logo Original layer. 

10. Type Command T to get the Free Transform Tools active. In 
the Options bar, scale the logo down to 15% in both directions. 
Move the logo down to the bottom of the cup, centered 
horizontally. 

11. Without exiting the Transform functions, go to Edit Transform 
Warp. In the Options Bar, change Warp to Arch (not Arc!), and 
change bend to -18. Press Enter. 

12. Select both the Prada Logo Original layer and the Prada Logo 
Altered layer and create a new group called Logo. 

13. Go to Image Canvas Size. Click on the middle left square, then 
increase the width of the canvas to 20 inches. Select all the 
layers in the Layers Palette and move the cup over to the left of 
the canvas. 
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14. Create a new layer below the Metal Cup layer and call it Black 
Background. Tip: with the Metal Cup layer selected, hold down 
the Command key and click on the New Layer button to 
automatically create the layer below the Metal Cup layer. Fill 
this layer with 100% black. 

15. Open the file GCM738_Tutorial_03_Prada_Text.psd. Right-
click on the layer in the file and choose Duplicate Layer. For 
the Destination, Select the working Photoshop file that we’ve 
been working on. Click OK. Go back to the working Photoshop 
file. Make sure the text layer is on top of all other layers. 

16. With the Prada Cup Text layer selected, create a new Layer 
Style Gradient Overlay. Create a new gradient with the 
following attributes: Stop 1, Location 0%, Colour Black; Stop 2, 
Location 25%, Colour 50% Grey; Stop 3, Location 50%, Colour 
White; Stop 4, Location 75%, Colour 50% Grey; Stop 5, 
Location 100%, Colour Black. Click OK. 

17. Under the Gradient Overlay Settings, make the Blend Mode 
Multiply, Opacity 50%, Style Linear, Align with Layer checked, 
Angle 45˚, Scale 60%. Click OK. 

18. The last step is to clean up the white showing around the cup. 
Select the Metal Cup layer, and use the Magic Wand to select 
the background, then inverse the selection (Shift Command I). 
Choose Select Modify Contract. Contract the selection by 1 
pixel. Next choose Select Modify Feather. Feather the selection 
by 0.5 pixels. 

19. Click on the Cup group, and choose Layer Layer Mask Reveal 
Selection. The edges on the cup are much smoother. 

20. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=69 

Conclusion 

This lab tutorial demonstrated several key tools and techniques we 
can use to create our own unique backgrounds from scratch, and 
explore ways we can work with everyday objects to add detail and 
enhance designs. 
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Tutorial 4 • Seeing is 
Believing: Creating Natural 
Compositions 

Overview 

A composite is when multiple images are brought together to make 
it seem like they are all part of the same image. This is to create 
the illusion that all of the separate image elements are part of the 
same scene. Sometimes photos are taken at different times or used 
with different cameras and Photoshop must be used to make the 
composite more natural-looking. This tutorial will look at different 
tips and techniques to make your composite appear more natural. 

Objectives 

• To understand how to analyze and determine which images are 
right for the same composite 

• To understand perspective as it relates to making your 
composite natural 

• To use layer masks to make images more natural 
• To better customize how auto-colour correction is used 
• To match brightness, colour and contrast from one image to 

another using adjustment layers 
• To use advanced methods of Curves 
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When selecting images for your composite, think about the 
lighting in these images and consider the following: 

1. What direction are the main light sources coming from in both 
images? 

◦ Make sure they are matching or can be matched 
◦ If the light source is coming from the opposite direction, 

flip the image 

2. How harsh is the light and what effect does it have on the 
shadows? 

◦ Is the light harsh and creating harsh shadows? (E.g. 
shadows created on a sunny day.) 

◦ Is the light not as harsh and the shadows are softer? (E.g. 
shadows created on a cloudy day.) 

3. What is the influence of the surrounding environment on the 
subject? 

◦ Are there reflections of light or colour on the subject? 

The more similar the direction of light, the more natural your 
composition will be. 

The more different the light sources are, the more editing will be 
required to make the composition look natural. Consider this when 
choosing images for your composition. 

Quick Compositing 

In this tutorial, we will be masking out a croissant from an image and 
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compositing it with another image of breakfast to make it appear 
natural: 

Photo by Brooke Lark on Unsplash [New Window] 
Photo by João Marcelo Martins on Unsplash [New Window] 

1. Open the tutorial file named 
GCM738_Tutorial_04_Breakfast.psd. Save it as 
GCM738_Tutorial_04_Breakfast_YourIntitials_v1.psd. 

2. Double click on the Background Layer and rename it to 
Original Image. 

3. Take a look at the shadows and the direction of the shadows in 
this photograph. 

4. Notice the soft shadows that are being created by the plates. 
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Positioning the Croissant 

1. Place Croissant.jpg into the file you just opened. 
2. Rename the layer as Croissant. 
3. Change the Opacity of the layer to about 40%. 
4. Click on the Croissant Layer, go to Edit → Transform → 

Rotate. In the Options Bar, change the angle to about 75 
degrees to match the shadows of the plates of the other places. 
We want the shadow inside of the plate to be on the right to 
match the other plates. 

5. Select the Move Tool, reposition and resize the layer so that 
the plate with the croissant fits the composition. Somewhere 
next to the plate in the centre and below the honey will work. 
Do not worry about the other elements around the croissant as 
they will be masked out. 

6. Click on the Checkmark in the Options Bar and change the 
Opacity of the Layer back to 100%. 

Masking out the selection 

1. Using the Object Selection Tool, select Lasso from the Mode 
drop-down menu in the Options Bar. 

2. Create a loose selection around the plate with the Croissant. 
Photoshop will use artificial intelligence to select the plate 
with the Croissant. 

3. Click on Select and Mask… in the Options Bar. 

1. If you need to, use the Quick Selection Tool or the Refine 
Edge Tool to adjust the selection. 

2. Under Refine Mode, select Object Aware. Click OK for the 
pop up. 

3. Under Global Refinements in the Properties Panel, adjust 
Smooth to 70. 
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4. Adjust Feather to 1px 
5. Adjust Contrast to 20% 
6. Adjust Shift Edge to -30%. 
7. Press OK 

4. With your selection made, create a Layer Mask to reveal the 
selection. 

Match the Brightness and Contrast 

1. Create a New Adjustment Layer and Select Black and White. 
This allows you to strictly look at the lightness and darkness in 
the image. 

2. Create a New Adjustment Layer and select Levels above the 
Croissant layer and ensure that it is a Clipping Mask to the 
Croissant Layer. 

3. Rename this layer to Brightness 
4. Notice how the plate is fairly gray. Select the White slider on 

the right hand slide under the Graph and slide it to a value 240. 
5. Delete the Black & White layer. 

Match the Colour 

1. Create a New Adjustment Layer and select Solid Color… and 
choose a bright orange colour. Any kind of orange will work. 

2. Change the Blend mode of the new adjustment layer to 
Saturation. This layer will help us to colour match the images. 

3. Create a New Adjustment Layer and select Colour Balance 
above the Croissant layer and ensure that it is a Clipping Mask 
to the Croissant Layer. 

1. Add more Red into the image and change the slide to +4. 
2. Add more Green into the image and change the slider to 
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+1. 
3. Add more Yellow into the image and change the slider to 

-4. 
4. Delete the Orange layer. 

The goal here is to match the colours of the plates in the croissant to 
the breakfast image. 

Create a Subtle Shadow 

1. Create a new blank layer under the Croissant layer and above 
the Original Image. 

2. Using the Eyedropper tool, select the colour of the darkest 
shadow from the original image. Notice that not all shadows are 
black. Some have a colour tint depending on the image. This is 
why we use the eyedropper tool. 

3. Select the Brush Tool, ensuring you have a soft round brush 
selected, change the brush size to 250 px and the Opacity to 
16%. 

4. Take your time and paint in the shadows where they would be. 
Use the other plates in the original image for reference. 

5. You can hold down the ~ key to erase away some of the 
shadows if you need to. 

Use a Colour LUT (Lookup Table) to tie it all 
together 

1. Create a New Adjustment Layer and select Colour Lookup. 
Ensure that it is at the top of your layers. 

2. From the dropdown menu where it says Load 3D LUT…, select 
a LUT that you feel works for your image. These work like 
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filters. If you feel the filter is too strong, feel free to adjust the 
Opacity of the layer. 

3. Save your file. 

Compositing with a Person 

The previous tutorial was a quick way to colour match objects that 
you choose to bring into your composition. This tutorial will now be 
a bit more complex but will help to make your compositions with 
humans more natural, especially if they are the main subject. 
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Photo by Matthew Henry on Unsplash [New Window] 
Photo by Breakreate on Unsplash [New Window] 

1. Open the tutorial file named 
GCM738_Tutorial_04_Nightscene.psd. Save it as 
GCM738_Tutorial_04_Breakfast_YourIntitials_v1.psd. 

2. Double click on the Background Layer and rename it to 
Original Image. 

3. Notice where the lights are coming from in this scene. Notice 
the colours they cast. Notice where the shadows fall. 

Masking your subject 

1. Place the Breakdancer.jpg file into the file you just opened. 
2. Change the Opacity of the layer to about 40%. Resize to about 

55% and position the dancer between the planter and the tree. 
Change the Opacity to back 100% once you are satisfied with 
the positioning and click on the checkmark in the Options Bar. 

3. From the Menu Bar, choose Select → Subject. 
4. In the Options Bar, click on the Select and Mask… button. 
5. Using the Refine Edge Tool or the Brush Tool with a soft brush 

to refine some of the ragged edges. Press OK. 
6. From the Menu Bar, choose Layer → Layer Mask → Reveal 

Selection. 
7. You can then turn off the background layer and refine the 
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mask with a smaller, black, hard brush if you wish. 

Adjusting Brightness and Contrast Using Levels 

1. Create a New Adjustment Layer and select Black and White. 
This allows you to strictly look at the lightness and darkness in 
the image. 

2. With the Breakdancer layer selected, create a New 
Adjustment Layer and select Levels. Make this a Clipping 
Mask for the Breakdancer layer and rename this to Brightness 
and Contrast. 

3. In the Properties Panel, slide the white stop to about 225 to 
adjust the highlights and make them slightly brighter. 

4. Slide the Black stop to about 25 to make the shadows slightly 
darker. 

5. Slide the Grey stop to about 1.2 to make the midtones slightly 
lighter. 

6. Ensure the Blend Mode of this layer is set to Luminosity. 
Although the change is very subtle, this ensures that the 
changes only affect the lightness and darkness of the image 
rather than the colours of the image. 

7. Delete the Black & White adjustment layer. 

Matching Colours 

1. Create a New Adjustment Layer and select Curves. Make this a 
Clipping Mask for the Breakdancer layer and rename this to 
Colour Matching. 

2. Ensure that the adjustment layer thumbnail is selected and not 
the adjustment layer mask. In the Properties Panel, hold down 
option (Mac) or alt (PC) and click on Auto. 
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3. In the Pop-up dialogue box, select Find Dark & Light Colors. 
4. Under Target Colors & Clipping, double click on the colour 

box next to the shadows. Click on the darkest area of the 
background image closer to the bottom of the stores. Notice 
that the shadows in this area are closer to blue. Once you have 
selected the shadow, click OK. 

5. Do the same for the highlights but select the lightest part of 
the image like brighter parts of the “OPEN” neon sign. 
Remember to not choose an area that is 100% white. You’re 
looking to get the colour of the cast in the highlights. 

6. A popup will ask if you want to save the new target colours as 
defaults. Select No. 

Adding Highlights and Shadows to the Image 

1. Consider where the highlights and shadows fall on your 
subject. Think about where the light source is and where it is 
coming from. 

2. Create a new blank layer and create a clipping mask to the 
Breakdancer. Change the blend mode to Multiply. Rename it 
Shadows. 

3. Using the Brush tool, ensure you have a soft round brush 
selected, change the size to 60 and the Opacity to 30%. 

4. Hold down option or alt to use the eyedropper to select a 
colour from the shadows. 

5. Lightly paint under the arm, torso and legs of the subject – 
anywhere the natural shadows would fall based on the 
lightsource. 

6. Create a new layer and clip it to the Breakdancer. Change the 
blend mode to Linear Dodge (Add). Rename it Highlights. 

7. Using the Brush tool, ensure you have a soft round brush 
selected, change the size to 60 and the Opacity to 15%. 

8. Hold down option or alt to use the eyedropper to select a 
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colour from the highlights. 
9. Lightly paint the top of the head, arm, torso and legs of the 

subject – anywhere natural highlights would fall based on the 
light sources. 

Create a Shadow of the Subject 

1. Create a new blank layer and name it Subject Shadow. Place it 
under the Breakdancer. 

2. With this new Subject Shadow layer selected, press Command 
or Ctrl and click on the Layer Mask of the breakdancer to 
create a selection. 

3. Turn off the Breakdancer layer for now. 
4. Select Edit → Fill and choose Color. You can now select a 

colour from one of the shadows. 
5. Cmd/Ctrl + D to deselect the image. 
6. Select the Move Tool, hold shift and resize the vertical 

proportions of the shadow so that it is “squished” and would 
appear as a shadow would. Click on the checkmark in the 
Options Bar. 

7. Select the layer, go to Filter → Blur → Gaussian Blur. Change 
the radius to 7px. 

8. Change the blend mode of this layer to Multiply and reduce 
the Opacity to about 60%. 

9. Turn the Breakdancer layer back on. 

Tie it all together with a Colour LUT 

A colour LUT (Lookup Table) is a method of colour grading your 
photos so that they have a distinct professional look. This is similar 
to using filters. 
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1. Create a New Adjustment Layer and Select Colour Lookup. 
Ensure this is not a clipping mask and that it is at the top of all 
of your layers. 

2. Under 3DLUT File, you can load any filter that you think is 
applicable for the image. For this tutorial, we will use Fuji 
ETERNA 250D Fuji 3510 (by Adobe).cube. 

3. If you feel that the colour LUT is too harsh, you can adjust the 
Opacity to your liking. 

4. Save your file. 
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Tutorial 5 • We the people: 
Retouching Humans 

Overview 

This lab tutorial will focus on Photoshop tools and techniques that 
can be used to retouch and alter people. While these tools and 
techniques can be used in some cases to work on non-human 
subjects, they tend to be particularly well-suited to working with 
the human form. 

Objectives 

• To introduce layers, layer groups, layer styles, and layer masks 
• To work with cloning tools (clone, Healing, Spot Healing) 
• To introduce colour correcting and replacing colour 
• To introduce the Warp feature 
• To work with the facial recognition features for the Liquefy 

Filter 
• To reinforce the principles of non-destructive editing 
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Procedure 

Retouching Eyes 

Eyes are a very common thing to retouch when working on an image 
of a person’s face. 

Let’s start by making the whites of the eyes whiter: 

1. Open the tutorial file named GCM738_Tutorial_04_Lady.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_04_Lady _Initials_v1.psd, where 
“initials” are your initials (e.g. 
GCM738_Tutorial_04_Lady_JL_v1.psd). 

3. Double-click on the Background Layer. Rename it Original 
Image. 

4. Create a new layer above the Original Image layer and name it 
Whiten Eyes. 

5. Zoom to 300% and position the image so the eyes are 
prominent. 

6. Select the brush tool, and choose a brush that has 0% hardness 
and is a size that will be appropriate for the task. 

7. Make sure the foreground colour is white. 
8. Make sure you are on the Whiten Eyes layer, and begin 

painting the whites of the eyes – don’t worry about being too 
“clean” as we will clean this up later. 

9. Reduce the opacity of the layer until it looks natural — 
approximately 30%. 

10. Use the eraser tool with a soft brush to clean up the edges of 
the eye whites. 

11. Zoom out to 100%, and review the results by toggling the layer 
visibility. 

Now let’s change the colour of her eyes to blue: 
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12. Create a new layer above the Whiten Eyes layer, and name it 
Blue Eyes. 

13. Zoom to 200%. 
14. Use the elliptical selection tool to draw a selection around the 

left iris. Save this selection as Left Eye. 
15. Use the elliptical selection tool to draw a selection around the 

right iris. Now Load selection, choose Left Eye as the channel, 
and choose the “add to selection” option. Now both irises 
should be selected. 

16. Choose Select Modify Feather, and feather the selection 0.5 
pixels. 

17. With the Blue Eyes layer selected, Choose Layer Layer Mask 
Reveal Selection. Note that the layer mask hides everything 
except the two iris selections. 

18. Make sure the image, not the layer mask is selected, then 
choose Edit Fill. 

19. Choose “Color” and pick a blue that is R 20, G 100, B 200 and 
click ok twice to get back to the image. 

20. Change the Blend Mode of the Blue Eyes layer to “Hue.” 
21. Now select the layer mask and use the brush tool to clean up 

the mask. 
22. Zoom out to 100% and check your work by toggling the layer 

off and on. 

Finally, let’s create a layer group to keep our work organized: 

23. Click on the layer group icon ( ) on the 
layers palette. 

24. Call this group Eyes. 
25. Select both the Whiten Eyes layer and the Blue Eyes layer and 

drag them into the Eyes group. 
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26. Your results so far should look like this: 

 

Smoothing Out Wrinkles 

The next step in our tutorial will be to smooth out some of the 
wrinkles in our model. 

Clone Tool 

Let’s start with the Clone Tool. The Clone Tool uses reference 
(source pixels) to replace target pixels. We will begin by removing 
the wrinkles under the mouth: 

1. Create a new layer, and name it Clone Tool. 
2. Select the Clone Tool, and make sure that Mode is set to 

normal, Opacity and Flow are at 100%, and that Sample is set 
to Current & Below. 
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3. Set the brush to be approximately 70 pixels, and with 0% 
hardness. 

4. .To fix the area to the left, pick source pixels just to the right of 
the blemish, then clone. 

5. To fix the area to the right, pick source pixels just to the left of 
the blemish, then clone. 

6. Now, let’s use the clone tool to remove the lines going from the 
nose to mouth on both sides – Tip: reduce the brush size down 
to around 30 pixels when cloning the detail around the nose. 

Healing Brush Tool 

The Clone Tool is great when there are the appropriate pixels to 
clone. Note however that to correct the wrinkles in our model’s 
neck, we don’t have pixels dark enough to sample from. This is 
where the Healing Brush comes in! It works on the same principles 
of the clone tool, but also matches shading and texture. Let’s use the 
Healing Brush to smooth out the model’s neck: 

1. Create a new layer, and name it Healing Brush. 
2. Select the Healing Brush Tool, and make sure that Mode is set 

to normal, Source is set to Sampled, and Sample is set to 
Current & Below. 

3. Use the Healing Brush to smooth out the wrinkles by sampling 
the skin in the bottom left side of the neck. Notice how it 
matches the tones! 

Spot Healing Brush Tool 

The Spot Healing Brush works under the same principle as the 
Healing Brush, only we do not need to choose source pixels. This 
brush is great for quick clean ups over small areas. Let’s use the Spot 
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Healing Brush to clean up some of the wrinkles on the face by the 
eyes and cheeks: 

1. Create a new layer, and name it Spot Healing Brush. 
2. Select the Spot Healing Brush Tool, and make sure that Mode is 

set to normal, Type is set to Content-Aware, and Sample All 
Layers is checked. 

3. Use the Spot Healing Brush to smooth out the wrinkles Under 
the eyes, the forehead and on the far sides of the cheeks. 

4. Do not retouch the eyelids yet. 

The Patch Tool 

The Patch Tool is great for replacing large areas of an image. We are 
going to use the Patch Tool to fix the scar on the right-side of the 
mouth, and to fix the wrinkles on the model’s eye lids. 

Let’s begin: 

1. The Patch Tool will not work on a blank layer, so duplicate the 
Original Image layer and name the duplicated layer Patch Tool. 

2. Select the Patch Tool, and make sure that Patch is set to 
normal, and that Source is selected. 

3. Select the area around the right side of the mouth, then drag 
to the left cheek to find the replacement patch. 

4. Repeat this process with the eyelids. 
5. The Finishing Touches. 

Let’s put the finishing touches on our retouching: 

6. Create a Layer Group, and call in Wrinkles. 
7. Move all the retouching layers we just made into the group. 
8. Select the layer group Wrinkles, and give it a layer mask and 

choose the option of hide all. 
9. Fill the layer mask with 30% black. This allows some of the 
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original image to show through, making the retouching a little 
more natural looking. 

Your results to this point should look like this: 

Retouching Teeth and Mouth 

We are going to replace the model’s mouth with another person’s 
mouth. 

Let’s start by fixing her lipstick: 

1. Place the New Smile file into the file. 
2. Use Cmd/Ctrl + T to resize the image. Resize it to about 15% 

and place it over the existing mouth. Change the opacity to 
help you see where to place the new smile. Be sure to make the 
opacity 100% once you are happy with the placement. 

3. Rotate the smile Clockwise about 2 degrees. 
4. Click on the checkmark in the Options Bar. 
5. With the New Smile layer selected, click on Layer → Layer 

Mask → Reveal All. 
6. Using a soft brush, paint away the outside of the mouth with 

black so it looks natural. 
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7. Create an Adjustment Layer and select Hue/Saturation. Name 
it Colour Match. Ensure that this is a clipping mask to the new 
smile. 

8. Change the Hue to +13 and the Saturation to -10. This will 
make the smile look more natural. 

9. Group the New Smile layer and the Adjustment Layer in a 
folder named Mouth 

Your image should now look like this: 

Changing the Hair Colour 

Now we are going to give our model a different hair colour. 
Let’s begin: 

1. Create a new layer above the Original Image layer, and name it 
Hair Colour. 

2. Set the layer blend mode to Colour. 
3. Change your foreground colour to be R 120, G 90, B 0. 
4. Use the paint brush to colourize the hair. Don’t worry about 

“staying in the lines.” 
5. Create a new layer mask for the Hair Colour layer, choosing 

Reveal All. 
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6. Use the paint brush to mask out the colour where you do not 
want it. Tip: Change the opacity of the brush to 25% to 
“feather” the colour near the hair line to make it look natural. 

 

Changing Facial Features Using the Liquify Filter 

Photoshop has very powerful facial recognition features that, when 
combined with the Liquify Filter, can make complex facial changes a 
breeze. 

Let’s begin: 

1. Select all groups and layers except for the Working Layers – 
Not Used group. 

2. Press Shift Command Option E to create a new merged layer 
from these layers without deleting the original layers. Name 
this merged layer Liquify. 

3. We are going to use the Liquify Filter as a Smart Filter so that 
we can maintain non-destructive editing. To do this, make sure 
the Liquify layer is selected, and then choose FilterConvert for 
Smart Filters. 

4. Now select FilterLiquify. 
5. On the tool bar on the left, make sure the icon of the person is 

selected. 
6. Make the model’s face wider by sliding the Face Width Slider 

right to 10. 
7. Make the model’s nose thinner by sliding the Nose Width Slider 

left to -15. 
8. Make the model’s eyes bigger by sliding the Eye Size Sliders. 

Note that the model’s eye on the left appears bigger than the 
none on the right. To fix this, slide the left slider to 50 and the 
right slider to 85. Also change the Eye height of the right eye 
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by sliding the Eye Height Slider to 35. 
9. Last, let’s tilt the model’s eyes. Click the chain link between the 

two Eye Tilt sliders, then slide them to 75. 
10. Toggle the Preview option off and on to see the results. 
11. Note that because we used this filter as a Smart Filter, we can 

go back and edit our work. We would not be able to do this if 
we did not convert to a Smart Filter. 

Your final image should look like this: 
 

Conclusion 

This lab tutorial demonstrated several key tools and techniques 
we can use to retouch people and faces. Please note that there are 
many other things we can do, and this tutorial is by no means an 
exhaustive example of everything Photoshop can do. 
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Tutorial 6 • Tricked Out 
Type: Creating Cool Type 
Effects 

Overview 

This lab will explore some of the ways we can use Photoshop to turn 
ordinary type into extraordinary art. 

Objectives 

• To demonstrate how to effectively use Photoshop to 
manipulate type for cool effects 

• To learn how create custom effects that can be used on type to 
enhance visual appeal 

Procedure 

Turning Type into a Neon Sign 
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Neon signs are visually attractive and can really garner attention. 
It is rare that we will actually have a neon sign that says exactly what 
we want. In this part of the tutorial we will fabricate our own neon 
sign from ordinary text. 

Let’s create the neon tubes: 

1. Open the file named GCM738_Tutorial_05_Neon_Text.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_05_Neon_Text_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Neon_Text_JL_v1.psd). 

3. Go to the Paths Panel, then click Text Path to activate it. 
4. Create a new foreground colour that is R 0, G 127, and B 254. 

Save this colour to the Swatches Panel with the name Top 
Blue. 

5. Select a brush that is 28 pixels in size and hardness of 0%. 
6. Create a new layer above the Background layer and name it 

Text Blue 28 px. 
7. In the Paths Panel menu, choose to stroke the path. In the 

dialogue box, change the tool to brush. 
8. Create a new layer above the Text Blue 28 px layer and name it 

Border. 
9. Go to the Paths Panel, then click Border Path to activate it. 

10. In the Paths Panel, stroke the path (Tip: you can do this the 
same way as before, or by clicking the Stroke path with brush 

button  at the bottom of the Paths Panel). 
11. Create a new Hue/Saturation Adjustment Layer and call it 

Colourize Border. Check the box “Use Previous Layer to 
Create Clipping Mask”. In the Properties Panel, check the 
Colorize box, then set the Hue to 0, Saturation to 25, and 
lightness to 0. 
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12. Create a new layer above the Colourize Border layer and name 
it White Glow. 

13. Choose the Brush Tool and reduce the size to 14 pixels. Change 
the foreground colour to white. In the Paths Panel, use the 
Stroke path with brush button to add a stroke to both the Text 
Path and Border Path. 

14. Create a new Layer Group called Neon Tubes and put all the 
existing layers except the Background layer in it. 

Let’s create a drop shadow for the neon tubes: 

15. Create a new foreground colour that is R 129 G 156 B 182 and 
save this colour to the Swatches Panel as Drop Shadow Blue. 

16. Increase the brush size to 50 px. 
17. Hide the Neon Tubes Group, and create a new layer above the 

Background layer. Call this layer Drop Shadow Text. 
18. Go to the Paths Panel and click on the Text Path to make it 

active. Use the Stroke path with brush button to add a stroke. 
19. Make the Neon Tubes group visible again. 
20. With the Drop Shadow layer selected, choose Filter Other 

Offset. Change the horizontal amount to 13 and the vertical 
amount to 8. Change the opacity of the layer to 50%. 

21. Create a new layer above the Background layer. Call this layer 
Drop Shadow Border. 

22. Change the brush size to 64 px, and change the foreground 
colour to R 178 G 39 B 27. Save this colour to the Swatches 
Panel with the name Drop Shadow Red. 

23. Again, add a stroke to the path and change the layer opacity to 
50%. 

Let’s create some reflections in the background: 

24. Create a new layer above the Background layer. Call this layer 
Blue Reflection 01. 

25. Change the foreground colour to Top Blue. 
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26. Go to the Paths Panel and activate the Refection Path. From 
the Paths Panel Menu, choose fill Path, and in the dialogue box, 
change the Feather Radius to 35 pixels. Deactivate the path. 

27. Change the opacity of the Blue Reflection 01 Layer to 25%. 
28. Create a new Layer above the Blue Reflection 01 layer and call 

it Red Reflection. 
29. Change the brush size to 150 px and change the foreground 

colour to Drop Shadow Red. 
30. Go to the Paths Panel and select the Border Path. Stroke the 

path then change the opacity of the Red Reflection layer to 
30%. 

31. Create a new Layer above the Blue Reflection 01 layer and call 
it Blue Reflection 02. 

32. Change the foreground colour to Top Blue, and the go to the 
Paths Panel and stroke the Text Path. 

33. Change the layer opacity to 50% and the Blend mode to Hard 
Light. 

34. Select the Text Blue 28 px layer and choose Select Load 
Selection. Channel should be set to Text Blue 28 px 
Transparency. Click OK. 

35. Choose Select Modify Expand, and expand the selection by 2 
pixels. Choose Select Modify Feather, and feather the selection 
by 5 pixels. 

36. Select the Drop Shadow Text layer and go to Layer Layer Mask 
Hide Selection. 

Let’s finish the sign with some tube connectors: 

37. Create a new layer above the Neon Tubes group. Call this layer 
Connectors. 

38. Change the size of the brush to 18 px, and make the hardness 
80%. Make the foreground colour 94% black. 

39. Go to the Paths Panel and make the Tube Connector Path 
active. Stroke the path. 

40. Change the brush size to 10 px with a hardness of zero. Change 

Tutorial 6 • Tricked Out Type: Creating Cool Type Effects  |  73



the foreground colour to 85% black. Stroke the path again. 
41. Move the Connectors layer under the Neon Tubes group and 

change the layer’s opacity to 40%. 
42. Save the file. 

A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=102 

Metal Type Effect 
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Do you want to create cool metallic-looking type? This tutorial 
goes through a simple process of how we can do this. I like to use a 
serif font as opposed a sans-serif font because the serifs give really 
cool angles and offer a lot of interest areas to the final product. 

Let’s start by creating the basic shape: 

1. Open the file named GCM738_Tutorial_05_Metal_Type.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_05_Metal_Type _Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Metal_Type_JL_v1.psd). 

3. Lock the transparency on the Text layer, and then fill the layer 
with R 128, G 128, B 128. Tip: the reason we are filling the text 
with a 50% gray is because it gives us the full upper half of the 
grayscale to create the highlights, and the full lower half of the 
grayscale to create the shadows. 

4. With the Text layer still selected, choose Layer Layer Style 
Bevel and Emboss. Set up the style as per the image below: 

5. We are going to make this metallic text look like a coppery 
bronze. To do this, let’s make a new fill layer. Choose Layer 
New Fill Layer Solid Color. Name the layer Orange, and click on 
Use Previous Layer to Create Clipping Mask. Click OK. 
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6. For the colour, choose R 205, G 111, B 0 and click OK. Note that 
even though the layer Blend Mode is set to normal, the colour 
appears transparent. This is because we used the layer below it 
to create a clipping mask. If we had not done this, the colour 
would have appeared opaque and solid. 

7. Now we will create a new “Stamp Layer” by pressing Shift, 
Option Command E. Name this layer Stamp Visible. 

8. Select the Magic Wand Tool. Set the tolerance to 4, and make 
sure Anti-Alias and Contiguous are both checked. Select the 
horizontal tops and bottoms of the type so you have a 
selection that looks similar to this: 

10. Choose Select Modify Expand. Expand the selection by 1 pixel. 
Save this selection as Tops/Bottoms. 

11. We no longer need the Stamp Visible layer, so let’s delete it. 
12. Go back to the Text layer, and double click on the Layer Style 

to modify it. Change the gloss contour to Half Round. This will 
make the highlights lighter, which is what we want for the next 
step. 

13. Go to the Channels Panel and duplicate the Blue Channel. 
Name this new Channel Left Side. Now choose Image 
Adjustments Levels. Move the white triangle for the input 
levels left until the third box has a value of 180. Click OK. 

14. With the Left Side Channel still selected, Command-click on 
the Tops/Bottoms Channel to create a selection. Fill this 
selection with Black. This removes these areas from the mask. 
Tip: You may need to use a hard brush with black to touch up 
any stray areas. 

15. Choose Image Adjustments Levels. Move the white triangle for 
the Input levels left until the right box has a value of 50. Click 
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OK. 
16. Duplicate the Left Side Channel and call it Right Side. Press 

Command I to invert the channel. 
17. With the Right Side Channel still selected, Command-click on 

the Tops/Bottoms Channel to create a selection. Fill this 
selection with Black. This removes these areas from the mask. 
Tip: You may need to use a hard brush with black to touch up 
any stray areas. 

18. Click on the RGB channel and return to the Layers Panel. 
Double-click on the emboss effect and change the gloss 
contour back to Cone Inverted. 

Now let’s create the texture for our type: 

19. Choose Image Duplicate 
20. Flatten the new duplicated image, and fill the canvas with R 

128, G 128, B 128. 
21. Save the Image to the Working Photoshop Files folder with the 

name 
GCM738_Tutorial_05_Metal_Texture_intitials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Metal_Texture_JL_v1.psd). 

22. Choose Filter Noise Add Noise. Make the Amount 125, and 
make sure Uniform and Monochromatic are selected. Click OK. 

23. Duplicate the Background layer and name the new layer Left 
Angle. 

24. With the Left Angle layer selected, choose Filter Blur Motion 
Blur. Set the Angle to 45, and the distance to 30. 

25. Duplicate the Background layer and name the new layer Top 
Angle. Move the layer to the top of the layer order. 

26. With the Top Angle layer selected, choose Filter Blur Motion 
Blur. Set the Angle to 90, and the distance to 30. 

27. Save the file. 
28. Hide the Top Angle layer and select the Left Angle layer. Select 

all and copy. 
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29. Return to the other file, make sure the Orange layer is 
selected, and load the Left Side Channel as a selection. Choose 
Edit Paste Special Paste Into. Name this layer Left Texture, set 
the Blend Mode to Multiply, and change the opacity to 40%. 

30. Now load the Right Side Channel as a selection. 
31. Choose Edit Paste Special Paste Into. Name this layer Right 

Texture. Choose Edit Transform Flip Horizontal so that the 
pattern is going in the opposite direction of the left side. Set 
the Blend Mode to Overlay. 

32. Go back to the texture file, make the Top Angle layer visible 
and select it. Select all and copy. 

33. Go back to the main file, and load the Tops/Bottoms Channel. 
Choose Edit Paste Special Paste Into. Name this layer Top/
Bottom Texture. Set the Blend Mode to Overlay. 

Now let’s Finish by adding some depth to our type by playing around 
with blend modes: 

34. Duplicate the Left Texture layer. Change the Blend Mode to 
Overlay and the Opacity to 100%. Call this layer Left Depth. 
This layer gives more detail to the texture without affecting 
the highlights. 

35. Duplicate the Right Texture layer and name it Right Depth. 
This has the same effect. 

36. Select the Top/Bottom Texture layer and change the Blend 
Mode to Multiply. This darkens these areas and gives a nice 
effect. 

37. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=102 

Plastic Type Effect 

Photoshop can be used to make plain type appear to be created 
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from extruded plastic. This is a cool effect that can be applied to a 
variety of scenarios. Let’s look at how this is done. 

Let’s begin by making the right shape for the plastic text: 

1. Open the file named GCM738_Tutorial_05_Plastic_Text.ai. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_05_Plastic_Text_Initials_v1.ai,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Plastic_Text_JL_v1.ai). 

3. Select all, then choose Effect Stylize Round Corners. Make the 
radius 0.1, and click OK. 

4. Select all and copy. 
5. Save the file and close it. 
6. Open the file named 

GCM738_Tutorial_05_Plastic_Type.psd. 
7. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_05_Plastic_Type_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Plastic_Type_JL_v1.psd). 

8. Make sure the foreground colour is set to neutral gray (R 128, G 
128, B 128). Choose Edit Paste to paste the copied artwork from 
the Illustrator file. In the Paste Dialogue Box, choose Shape 
Layer. Tip: The reason we are pasting this as a shape layer is 
that the original artwork was vector. By creating a shape layer, 
the artwork is pasted on its own layer as a vector graphic and 
uses the foreground colour as the fill. Since the path that 
defines the shape is vector, it can be scaled and otherwise 
transformed without loss of quality. 

9. Name the new layer Text Outline. 
10. Go to the Paths Panel. Notice that a temporary path was 

imported with the Shape Layer. Name this Path Text Path. This 
adds the shape as an editable path to the Paths Panel. 

11. Choose Layer Layer Style Bevel & Emboss. Make sure your 
settings look like the image below: 
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12. Hold down the Command key and click on the icon on the Text 
Outline layer to load the shape as a selection. Choose Edit 
Copy Merged. Name the new layer created Plastic Text Tip: 
Copy Merged copies the selected artwork as though all the 
layers were merged and the image was flattened – or in other 
words, it copies the artwork as it appears, regardless of how 
many different layers are used to create the appearance. 

13. Hide the Text Outline layer. 
14. Now let’s add some colour: 
15. With the Plastic Text layer selected, choose Layer New Fill 

Layer, and choose solid colour. Name the layer Gold, and check 
Use Previous Layer to Create Clipping Mask. Click OK. Make the 
colour R 255, G 234, and B 94. 

16. Set the Blending Mode of the Gold layer to Soft Light. 
17. Choose Layer New Adjustment Layer Hue/Saturation. Name 

the layer Saturation Bump, and check Use Previous Layer to 
Create Clipping Mask. Click OK 

18. Adjust the saturation to +50. 
19. Now let’s add detail: 
20. With the Saturation Bump layer selected, choose Edit Copy 

Merged. Name the new layer Plastic Wrap. 
21. Using the Rectangular Marquee, select the left half of the 

canvas up to the split between the S and T. 
22. Choose Filter Filter Gallery. Choose the Artistic folder, and 

choose the Plastic Wrap effect. Set the Highlight Strength to 
15, The Detail to 8, and the Smoothness to 9. 

23. Inverse the selection. Reapply the filter we just used by 
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selecting Filter Gallery from the very top of the filter menu. 
Deselect the selection (Command D) 

24. With the Plastic Wrap layer selected, Command-click on the 
Text Outline layer to create a selection. 

25. Create a layer mask on the Plastic Wrap layer by clicking on 
the Add Layer Mask button at the bottom of the Layers Panel. 

26. Using Blend Modes to change the look: 
27. Select the Plastic Wrap layer. Change its Blend Mode to Hard 

Light. Tip: The Hard Light Blend Mode saturates the yellow 
overall by removing the midrange effects of the filter while 
maintaining the highlights. This makes our text look like 
extremely bright, shiny plastic. 

28. Now change the Blend Mode to Lighten. Tip: With the Blend 
Mode set to lighten, only the areas of the Plastic Wrap layer 
that are lighter than those of the layers below will be visible. 
The result is less shine, and more detail in the midtone. 

29. Now change the Blend Mode to Luminosity. Tip: With the 
Blend Mode set to Luminosity, the brightness information of 
the Plastic Wrap layer is applied to the layers below. This 
maintains the highlights, but still allows the midtones to show 
through. 

30. Save the file 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=102 

Rusty Type 
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Cool, sharp new metal type can serve a purpose, but what if we 
want our metal type to look like it has seen better days? With the 
right tools and techniques, we can create realistic looking rusted 
type that create a cool effect for art. 

Let’s begin: 

1. Open the file named GCM738_Tutorial_05_Rusty_Type.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_05_Rusty_Type_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_05_Rusty_Type_JL_v1.ai). 

3. Hide the visibility of the Original Text shape layer. Duplicate 
the Rust layer and call it Rusty Text. Make this layer visible. 

4. Go to the Paths Panel and select the path called Text Path. 
5. Choose Layer Vector Mask Current Path. 
6. Hide the Black Iron layer so we can see the changes we are 

about to make. 
7. With the Rusty Text layer selected, choose Layer Layer Style 

Bevel & Emboss. Make sure your settings look like the image 
below, and do not close this dialogue box yet: 

8. Change the colour of the highlight to R 250, G 250, B 150. Click 
OK, but still do not close the main dialogue box. 

9. Click on Drop Shadow in the list on the left side of the dialogue 
box, and set up the drop shadow to match the settings below: 
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10. Click OK to close the dialogue box. 
11. Select the Rusty Text layer, and Command click on the Vector 

Mask to make a selection. Create a Layer Mask with the button 
at the bottom of the Layer Panel. Option-click on the Layer 
Mask to show the contents of the Layer Mask instead of the 
Layer. 

12. Make sure the Layer Mask is selected. Choose Filter Filter 
Gallery, go to the Brush Strokes folder, and choose Spatter. 
Make the Spray Radius 25 and Smoothness 15. Click OK. 

13. Click on the layer icon to show the layer contents, and mask 
the Black Iron layer visible. 

14. Select the layer mask on the Rusty Type layer once again. Make 
sure the foreground colour is set to black. 

15. Select the Brush Tool. Choose a Spatter Brush with a radius of 
59 pixels. Change the Opacity of the Brush to 30%. Now you 
can add some erosion to the inside of the text as well. Try to be 
random as you click. 

16. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=102 

Conclusion 

This lab tutorial demonstrated several different ways we can turn 
ordinary type into attractive headlines. These are just a small sample 
of the many different ways Photoshop can be used to enhance type 
for visual appeal. 
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Tutorial 7 • Master 
Manipulator: Advanced 
Photoshop Tips and Tricks 

Overview 

In this tutorial we will explore some of the more advanced things we 
can do in Photoshop to manipulate images. 

Objectives 

• To demonstrate how to effectively use the Puppet Warp 
feature in Photoshop. 

• To learn how to effectively crop out people with curly or fly-
away hair. 

• To use advanced techniques to add a rain effect to an image. 
• Used advanced techniques to turn a daytime scene into a 

nighttime scene. 

Manipulating an image using Puppet Warp 

The Puppet Warp feature in Photoshop is a very powerful tool that 
lets us distort images in almost endless ways. Puppet warp is very 
useful for making artwork conform to a complex shape, as well as to 
modify the look of existing images. 

Let’s begin: 
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1. Open the file named GCM738_Tutorial_07_Swan.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_07_Swan_Initials_v1.psd, where 
“initials” are your initials (e.g. 
GCM738_Tutorial_07_Swan_JL_v1.psd). 

3. Rename the Swan layer to Swan Original. 
4. Duplicate the Swan Original layer and name the duplicated 

layer Swan Puppet Warp. Hide the visibility of the Swan 
Original layer. 

5. Go to Edit Puppet Warp. You will see a mesh that appears that 
covers the entire contents of the layer. This mesh is what we 
will manipulate to change the image. TIP: If you do not see a 
mesh, make sure the Show Mesh is checked in the options bar. 

6. Before we manipulate the image, we will want to add some 
pins to the mesh. The areas we add the pins to will remain 
unaffected by the warp, and will be locked in place. Use the 
image below as a guide as to where to set the pins. 

7. Click on the pin at the base of the head, and float the cursor 
over the pin until you see the cursor change from a pin to a 
cursor, the click and drag to move the head to the right, so that 
it looks like the image below. 
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8. Next click the pin in the middle of the neck, and use it to move 
the neck to the left slightly 

9. Add a pin between the two pins you just manipulated, and then 
adjust all three until you get a natural looking curve similar to 
the image below. TIP: You can toggle the mesh off and on to get a 
better look at your work 

10. When you are happy with how the neck looks, manipulate the 
pin on the neck reflection to mimic the changes you made 

11. When you are happy with your work, press return to commit 
to the warp 

12. Save the file 
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Close Cropping Curly and Fly-Away Hair 

Cropping curly and fly-away hair so that it looks natural can be a 
challenge. In this portion of the tutorial we will look at one way we 
can do this the gives us great results! 

Let’s begin: 

1. Open the file named GCM 
738_Tutorial_07_Hair_Background.psd. 

2. Save the Image to the Working Photoshop Files folder with the 
name GCM738_Tutorial_07_Hair_Merged_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_07_Hair_Merged_JL_v1.psd). 

3. Now open the file named 
GCM738_Tutorial_07_Hair_Model.psd. 

4. Save the Image to the Working Photoshop Files folder with the 
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name GCM738_Tutorial_07_Hair_Model_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_07_Hair_Model_JL_v1.psd). 

5. With the Model layer selected, and the Quick Selection Tool 
selected, in the Options Bar, click on Select Subject. 

1. Click on Select and Mask… 

1. Using the Refine Edge Brush Tool, set your brush size 
to about 90px 

2. Ensure that in the Properties Panel, view mode is set 
to Overlay and Real-time Refinement is selected. 
Opacity can stay at 50%. 

3. Ensure that the refine mode is set to Color Aware and 
not Object Aware. All other settings are set to 0. 

4. With the Refine Edge Brush Tool, paint over the areas 
where there is blue in her hair from the background. 
You could also select Refine Hair in the options bar. 
This will remove the blue background from her hair. 

5. Use the same brush to get rid of the blue background 
between her waist and arm. 

6. When you are satisfied, select OK. 
2. Choose Layer → Layer Mask → Reveal Selection. 

6. The model is now cropped, but you will notice that there is a 
lot of blue fringing from the reflection of the blue background. 
This is called spill, and we need to correct this. Let’s fix the 
spill: 

1. Create a new layer under the Model layer, and name it 
Temp Background. Fill this layer with black. This will help 
us to see the colour correction better. 

2. Create a new layer, and clip it to the Model layer. Name 
this layer Spill Correction. Change the Blend Mode to 
Color 

3. Select a brush with a nice big radius, and make sure the 
Hardness is set to 0.  Hold down the option key and select 
an area of the hair that is close to the color you want to 
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use, then begin painting over the blue areas. TIP: Sample 
different colours in the hair as you go to make it look 
natural. If you are unable to sample colours, click on the 
Eyedropper tool and ensure that “All Layers” is sampled from 
the drop down menu in the Options Bar. 

4. Reduce the size of the brush and continue this process for 
the rest of the model, including the face, arms and shoes 

5. Hide the Temp Background Layer, so only the Spill 
Correction and Model layers are visible. Select both layers 
and press shift, command, option + E to make a merged 
layer from those two layers. Name the new layer Model 
Finished 

Now we need to place our model in the background image: 

1. Choose Layer → Duplicate Layer. Under destination, 
choose the Hair Merged file. Save the model file and close 
it. 

2. Go to the Hair Merged File. Choose Edit → Transform → 
Scale, and scale both the width and height to 80%. 
Position the model so she is standing in front of the pillar 

3. Now let’s add a drop shadow to make it look a little more 
natural. Choose Layer → Layer Style → Drop Shadow, and 
create a shadow as per the settings below: 

26. Save the file and close it. 
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Note: This video uses a different method than above to crop the curly 
hair. This method in the video below can be useful to select other 
irregular shapes. The method outlined above is a newer feature 
created by Adobe to make cropping hair more natural, efficient and it 
takes less time. 

A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=118 
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Making a Rainy Day 

Using the power of Photoshop, we can change the weather! In this 
part of the tutorial, we will make an ordinary overcast day into a 
stormy rainy day. 

Let’s begin: 

1. Open the file named GCM738_Tutorial_07_Rain.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_07_Rain_Initials_v1.psd, where 
“initials” are your initials (e.g. 
GCM738_Tutorial_07_Rain_JL_v1.psd). 

3. The first thing we need to do is prep the image to look even 
more gloomy. We will start by adding a new Exposure 
Adjustment Layer that we will name Darken. Adjust the 
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exposure to -0.60. 
4. Go to Layer New Fill Layer Gradient. Name this adjustment 

layer Vignette. Choose a Radial gradient and make sure both 
colour stops are black. Click reverse, and set the scale to 250%. 
Click OK, and then change the layer opacity to 50%. 

5. Now let’s make the rain. Create a new layer above the Vignette 
layer and name it Rain. Fill the layer with black. 

6. Choose Filter Noise Add Noise. Set the Amount to 60, 
Distribution to Gaussian, and check Monochromatic. Click OK. 

7. Choose Filter Blur Blur More. 
8. Choose Image Adjustments Levels. Under Input Levels, make 

the value of the left box 50 and the value of the right box 95. 
Click OK. 

9. Choose Filter Blur Motion Blur. Set the Angle to -75 and the 
Distance to 30. Click OK. 

10. Choose Image Adjustments Levels again. Under Input Levels, 
make the value of the left box 50 and the value of the middle 
box 0.5. Click OK. Change the layer blend mode to Screen. 

11. To make the rain even more pronounced, duplicate the Rain 
Layer and name the new layer Rain 2. Change the opacity of 
the layer to 50%. 

12. Save the file. 

Tutorial 7 • Master Manipulator: Advanced Photoshop Tips and Tricks  |  95



Turning Day Into Night 

Using the power of Photoshop, we can also time travel! In this part 
of the tutorial, we will take a day scene and turn it into a night scene. 

Let’s begin: 

1. Open the file named GCM738_Tutorial_07_Nightime.psd. 
2. Save the Image to the Working Photoshop Files folder with the 

name GCM738_Tutorial_07_Nightime_Initials_v1.psd,
where “initials” are your initials (e.g. 
GCM738_Tutorial_07_Nightime_JL_v1.psd). 

3. Before we do too much to this file, we are going to save some 
selections for the windows, that we will use later to create the 
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effect that there are lights on in the castle. 
4. Zoom in to 200%. Use the pen tool to create a path for the 

outline of the two main windows. When done, save the path as 
Window Shape. TIP: When using the pen tool, click hold and 
drag to create a curved line, and option click on the last point to 
reset the curve. 

5. Select the Window Shape Path and turn it into a selection. Save 
this selection as Windows. 

6. Go to the Channels Panel and make the Windows channel 
visible along with the RGB channels. You should see a red mask 
over everything but the windows. 

7. Select the Windows channel, and then choose a soft round 
brush that is 3 pixels in radius with 0 hardness. Make sure the 
foreground colour is set to black. Use the brush to draw in the 
horizontal and vertical grates in the windows. TIP: To make 
straight lines, click once at the start of the line, then shift-click 
at the end. 

8. Hide the visibility of the Windows channel and make sure the 
RGB composite channel is selected. Go to the Layers Panel and 
double-click on the Background Layer and rename it Original 
Image. 

9. We are going to want to crop out the sky so we can replace it 
with a nighttime sky. Let’s start by duplicating the Original 
Image layer and name the new layer Sky Mask. Hide the 
visibility of the Original Image Layer. 

10. With the Sky Mask Layer Selected, go to Select Color Range. 
Select should be set to Sampled Colors, uncheck Localized 
Color Cluster, Set Fuzziness to 60, uncheck invert selection, 
and set Selection Preview to Grayscale. Shift-click on the areas 
of the sky until the sky is completely white, and the castle is 
almost entirely black. Click OK. 

11. With the selection still active, expand the selection by 3 pixels, 
and feather it by 0.5 pixels. 

12. Choose Layer Layer Mask Hide selection. Option-click on the 
mask icon to see the mask contents, and use the brush tool 
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.(hardness set to 100) with white as the foreground colour to 
remove any black areas from the castle. Option-click on the 
mask icon again to see the castle. 

13. Create a new layer under the Sky Mask layer and name it 
Temp Sky. Fill the layer with black. 

14. Create a new Hue/Saturation Adjustment Layer above the Sky 
Mask layer. Name this layer Castle Colourized. Click the 
Colorize button, then set the Hue to 230, Saturation to 20, and 
Lightness to -30. This gives our castle a nice eerie blue cast 
and darkens it. 

15. The tower on the left needs to be in shadow. Create a new 
layer above the Sky Mask layer and name it Left Tower 
Shadow. 

16. Using the Polygon Lasso Tool, draw a selection around the 
tower. TIP: You can do a quick and rough selection here and 
clean it up with the Brush Tool where needed after the mask is 
made. Feather the selection by 0.5 pixels, then choose Layer 
Layer Mask Reveal Selection. 

17. Fill the layer (not the mask) with black, change the layer Blend 
Mode to Darken, and reduce the opacity to 30%. 

Now let’s turn some lights on in the castle: 

18. Create a new layer above the Castle Colourized layer, and 
name in Window Lights. 

19. Change the foreground colour to R 240, G 250, B 0, and the 
background colour to R 160 G 75 B 0. 

20. Load the Windows selection. 
21. Choose the Gradient Tool. Select the foreground to 

background gradient and choose a Radial Gradient Style. Pick a 
point between the two windows and draw a line diagonally to 
create the window lights. Adjust the gradient until you are 
happy with it. 

22. The windows would create a glow or cast on the brick outside. 
To make this, duplicate the Window Lights layer and name the 
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new layer Window Glow. 
23. Choose Filter Blur Gaussian Blur, and set the Radius to 20 

pixels. Click OK. 
24. Choose Layer Layer Mask Reveal all. Use the brush tool to 

mask away the blur from the windows, leaving just the glowing 
edges. Also use the brush tool to remove the glow from the left 
side and bottom of both windows. 

Now we have to finish the sky: 

25. Open the file GCM738_Tutorial_07_Storm_Clouds.jpg. 
Select all and copy. 

26. Go to the nighttime image. Select the Temp Sky Layer and 
then paste the cloud image. Name the new layer that is created 
Storm Clouds. TIP: Selecting the Temp Sky layer first ensured 
the cloud image would be pasted in the correct layer order. 

27. Scale the clouds to 87% and then position them appropriately. 
28. Create a new Hue/Saturation layer above the Storm Clouds 

layer. Name it Darken Clouds. Lower the Lightness to -40. 
29. Delete the Temp Sky layer. 
30. Save the file. 
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A YouTube element has been excluded from this version of the 

text. You can view it online here: 

https://pressbooks.library.ryerson.ca/photoshopped/?p=118 

Conclusion 

This lab tutorial demonstrated more advanced tips and tricks that 
can be used to enhance photographs beyond simple retouching. 
Using a combination of tools and techniques, including creating 
our own interest areas, such as rain, can dramatically change the 
appearance of an image. 
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Appendix — Image Credits 

“Adobe Photoshop screenshot(s) reprinted with permission from 
Adobe Systems Incorporated. Adobe® and Photoshop®  are either 
registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. Screen 
captures cannot be cropped.” 
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